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Contacting Infor

If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and create
a support incident.

The latest documentation is available from docs.infor.com or from the Infor Support Portal. To access
documentation on the Infor Support Portal, select Search > Browse Documentation. We recommend that
you check this portal periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Chapter 2: Introduction

PLM interfaces directly with SolidWorks, facilitating direct transfer of product designs from the SolidWorks
environment into PLM and then ERP. This eliminates the inherent risks and errors associated with data entry
from multiple sources. SolidWorks files can be managed according to configuration management methodology,
while facilitating the direct transfer of complete design Bills of Material (BOMs) to the production
environment.Main features of the integrationMain features of the integration

Viewing design files is no longer a privilege afforded only to engineering departments. All authorized users
are provided with the tools to search, browse, view and manipulate documents from a secured central
database, enhancing collaborative teamwork.

Using the embedded PLM menu and toolbar, the PLM integration for SolidWorks provides access to PLM
functionality from within the native working environment.

This integration connects engineering workgroups to the entire enterprise in the native SolidWorks
environment. SolidWorks and PLM exchange product information, and update files and documents throughout
the design process.

Main features of the integration
The PLM integration for SolidWorks includes the following features:

• Files can be saved from SolidWorks to PLM.
• Document link management.
• Unique file names for all new SolidWorks files.
• SolidWorks files can be revision controlled.
• Concurrent engineering features enables you to manage ownership of the files.
• Files can be retrieved from the PLM using the Download Manager.
• Bill of Material (BOM) is transferred to PLM when you save files to PLM.
• Support for design variants enables you to assign an item to the configuration. As a result, you can transfer

the BOM of a design variant(configuration) to PLM.
• Advanced query mechanism for searching objects in PLM.
• Role-based authorization allows users to perform operation based on their roles.
• Files can be automatically saved to PLM in neutral formats such as PDF, BMP and so on. Neutral files can

be viewed using applications that are not CAD specific
• Built-in file viewer.
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• Thumbnails of CAD files can be generated and stored in PLM database for snapshot view of the design
files.

• The design process can be controlled using the workflow functionality.
• Preferences to control the behavior of the integration. Example: integration preference, Set Object to

Match File Name enables you to save the files using a specific file naming convention.
• Mapping functionality enables you to transfer values, such as, document properties, custom properties,

and so on, from CAD file to PLM and vice versa.
• Graphic representation of product trees.
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Chapter 3: Getting Started

The following topics are available to help you getting started with the PLM integration for SolidWorks:

• Installing the Integration on page 13
• Requirements
• PLM embedded menu and toolbar on page 14

Note: It is essential that the administrator sets up the integration correctly before users start to work with it.

Software Configuration
For the latest PLM Server, Infor PLM and SolidWorks Integration Kits, refer to the latest release notes.

To install the integration kit
To install the integration kit, extract the Integration kit zip file to the local system. It is suggested to install
the integration kit from the local setup files for all the components.

Installing the Integration
To install the integration:

1 Before installing the PLM integration for SolidWorks, the SolidWorks must be installed.
2 To install the SolidWorks integration, double click the .msi file, and follow the instructions of the install

shield.
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PLM embedded menu and toolbar
After the PLM integration for SoldWorks has been installed, the PLM toolbar is added to your SolidWorks
toolbar, and a menu is added to the SolidWorks menu

bar.

Connecting to PLM on page 17Connect

Disconnecting from PLM integra-
tion on page 17

Disconnect

Managing design variants/ config-
urations on page 44

Capture Design Varients

Link to Item on page 24Link to Item

To save a file to PLM on page 19Save to PLM

Saving and Unlocking Files on
page 27

Save and Unlock

Checking in a File on page 28Check In

Checking out a File on page 30Check Out

Checking out a File on page 30Check Out Major

Taking Ownership on page 32Take Ownership

Changing the ownership of a file
on page 32

Change Ownership
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Dispatch to business process on
page 49

Dispatch to Business Process

Refresh Files from PLM on page
43

Refresh Files from PLM

Opening a file in PLM on page 36Show Document Structure

Opening a file in PLM on page 36Show Item Structure

Using Infocards on page 37

Using Infocards on page 37Update Document

Using Infocards on page 37Update File

Synchronize Headers on page 39Synchronize Headers

Viewing PLM Data on page 34Show Meta Data

Clear Storage Information on page
41

Clear Storage Information

Delete Local Files on page 42Delete Local files

For information on mapping, see:
• Display Mapping on page 65
• General Mapping on page 58

Display Mapping Rules

The Associate Mapping Rules
menu option on page 63

Associate Template Mapping

Removing mapping associations
on page 64

Remove Mapping Association

Integration Preferences on page
97

Preferences

Contains product and system in-
formation as well as additional
sources for professional assis-
tance.

About

Creates both the document and
item when you click Save to PLM.

To Toggle the Integration Prefer-
ence (Create Document + Item)

Creates only document when you
click Save to PLM.

To Toggle the Integration Prefer-
ence (Create Document Only)

Disables the Save Only Modified
File integration preference

To Toggle the Integration Prefer-
ence [Save Only Modified File] to
False
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Enables the Save Only Modified
File integration preference

To Toggle the Integration Prefer-
ence [Save Only Modified File] to
True
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Chapter 4: Working with PLM

This section contains the following topics that describes the tasks to be executed while working with PLM:

• Connecting to PLM on page 17
• Opening a file in PLM on page 36
• Disconnecting from PLM integration on page 17

Connecting to PLM
To use PLM Integration for SolidWorks, you need to establish connection between SolidWorks andPLM. The
connection gives you access to the PLM database and projects that you need to work with.

To connect to Infor PLM Discrete:

From the SolidWorks application, do one of the following:

• Click the Connect icon in the PLM integration toolbar.
• Select Connect in the PLM drop-down menu.

The functions in the PLM menu and toolbar are enabled.

Disconnecting from PLM integration
Disconnecting is a global operation for all SolidWorks integration applications; disconnecting from one
SolidWorks application disconnects all connected SolidWorks application from PLM.

To disconnect from the PLM integration, do one of the following:

• Select Disconnect from the PLM integration drop-down menu.
• Click Disconnect in the PLM integration toolbar.
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Chapter 5: Saving Files to PLM

When any SolidWorks file, such as a drawing, is saved to PLM, it is represented by two PLM objects that are
linked to each other:

• A PLM file, which is revision-controlled, and which specifies the location of the SolidWorks file, together
with additional data about it. This PLM file (also known as a data set) has the same name as the SolidWorks
file.

• A PLM document, which is also revision-controlled, and which contains attributes that describe the
characteristics of the file. The file’s name is held in the document’s Description attribute.

If the active SolidWorks file is a model (component or assembly), an item can be created and linked to the
document. This depends on your preference settings. If the file has children (components), the child objects
are also saved in PLM. Files, documents and items are created for each component.

Document links are created representing the assembly-component relationships to the newly saved files as
well as to the components that were previously saved in PLM.

When you perform the Save to PLM operation on a SolidWorks file, the document is saved with the status
Draft. Each consecutive save updates the latest changes performed on the Draft revision of the document
in PLM.

You can only save a file if its related PLM document has a status of Draft. If the document has the status
UNDER CHANGE or RELEASED, the file cannot be saved to PLM.

To save your changes on the server (not only locally), first save the file locally, and then perform the PLM
action, Save to PLM.

Saving an existing file to PLM also saves the file in SolidWorks. If you save the file only to SolidWorks, the file
is saved only locally and the associated documents and/or items in PLM are not saved.

The assignment of attributes during the save is determined by the parameters set up for you by the
administrator in your preference settings. If the Set Object Attribute During Save check box is selected in
the preferences, you can define attributes for the files, documents, and items that you save to PLM.

If you are working with design variants, known as configurations in SolidWorks, you must capture the data
of the design variants before you save the item to PLM. For more information, refer to Managing design
variants/ configurations on page 44.
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To save a file to PLM
Before you can save a file to PLM, you must save it in SolidWorks with a unique name.

Note: 

• Do not use & < > ' “ symbols in the file names that you save to PLM, this will cause errors to occur.
• If you are working with design variants and you want to save the design variants as well, complete the

Capture Design Variant process before you save a file to PLM.

To save a file to the PLM, do one of the following:

• Click Save to PLM in the PLM toolbar.
• Select Save to PLM from the PLM menu.

Clicking Save to PLM in the menu or the toolbar results in one of the following:

• If all the IDs are generated automatically by PLM, which you can specify in the preferences, the file is
saved.

• If the Set Object Attribute During Save check box is selected in the integration preferences, the Set
Object Attributes dialog box

appears.

In this dialog box, you can switch between the File, Document, and Item tabs and for each tab you can update
any attribute. After you finish updating attributes, click OK in this dialogbox.

For attributes that you do not update, the PLM default values are automatically inserted. For further
information, see Initial Save Option on page 99.

While saving files to PLM, the integration checks whether you own the files being saved. Editable files that
are not owned by you or by any other users are displayed in the Taking Ownership on dialog box. In this dialog
box, select the files that you want to save to PLM. See Taking Ownership on page 32

The Integration saves the files, documents, and items to the PLM database and creates hierarchical links
between the documents, files, and items for the assembly documents and the bill of material.
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When you create a drawing for a part and click Save to PLM, the integration creates files and documents for
the drawing, and in the hierarchy, links the item of inserted part as a model to the drawing

document.

Saving a file and creating a document
To save a file to PLM and create only a document.

It is assumed you have the correct preference settings selected to create a document only. For more
information, seeIntegration Preferences on page 97 .

1 Select Save to PLM from the PLM drop-down menu or click Save to PLM icon on the toolbar. As a result,
the Attributes for File-Documents-Items dialog box appears. The Item tab displays no data and the item
fields are not accessible since your preferences are set up to create a document only.

2 After updating the relevant attributes, click OK. As a result, only the documents and files are created in
PLM, and not the items.
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Chapter 6: Download Manager

The download manager retrieves the latest files from the PLM database and saves them to the local work
directory of the user. The download manager is the basis of the following PLM preferences:

• File Name Uniqueness on page 21
• Download Additional Drawings on page 21
• Indicator for Locally Changed Files in Download Manager dialog on page 22
• Skip Mapping for Released Files on page 22
• Skip Meta Data Comparison During Download on page 23

File Name Uniqueness
If this check box is selected, in the General Option of PLM preferences, the names of the files stored in PLM
are maintained as unique.

If this check box is cleared, you can store multiple files with identical file names in PLM but in different projects.
It is not recommended to clear this check box, since it might cause problems if you want to download a file
while a file with an identical name already exists locally. For example, you cannot use multiple files which
have identical file names; from different folders; in one assembly.

Download Additional Drawings
If this check box is selected, in the General Option of PLM preferences, the Edit/View file in Integration
option enables the user to download the related drawings of all the models in the current Document structure.
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Indicator for Locally Changed Files in Download Manager
dialog
The value Y for the Identical field of the PLM - Download Files dialog box distinguishes between the files that
are changed in PLM and locally by the user.

Following are the possible values for the Identical field:

• Y: Local file is identical to the file in PLM.
• N: The file in PLM is different from the file on the local system.
• Y - Locally Changed: Indicates the file in PLM is not changed, but there are some changes made to the

file on the local system.

Download Files - Commands:

• Progress Bar: The progress bar indicates the status of downloading of the files from the PLM to the local
system.

• Select the Skip Mapping for Released Files check box to skip the To-CAD mapping for the files that are
in Released status in PLM. The default value for this check box is defaulted based on the integration
preference Skip Mapping for RELEASED files during Download. You can select the check box to download
large assemblies in order to improve the performance of the download operation.

• Refresh Already Open Files: Synchronizes the currently open file with the latest file in PLM.
• Restore Archived Files: Retrieves the file from the archive area.

Skip Mapping for Released Files
When you select the preference Skip Mapping for Released Files during Download in the General Option
of PLM preferences, the integration does not perform the mapping for the files which are in Released status
in the PLM during the download process. It is recommended to select the check box to improve the download
performance of large assemblies in the View/Edit File operation. However, you should be aware that some
file preferences may not be up to date with PLM.
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Additionally, it is also possible to select the Skip Mapping for Released Files during the download process.
Select Skip Mapping for Released Files check box to skip the mapping for the released

files.

The default value for this check box is defaulted based on the integration preference Skip Mapping for
Released Files.

Skip Meta Data Comparison During Download
When Skip Meta Data Comparison During Download check box is not selected in the General Option of PLM
preferences, the download manager indicates the changes if any, in the PLM database.

The Download Manager indicates if there is any change in the PLM data of Document/ Item/File.

In case the Download Manager indicates the data change, it is recommended to download the indicated files.
Hence the Download option for the specific changed file is selected by default.
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Chapter 7: Link to Item

If the preferences specify that no items must be generated for part files on initial save to PLM, you must use
the Link to Item option from the PLM menu to create items for the part file that you are working on, or to
link the part file to an existing item in the PLM database.

If you click this option, the Link to Item dialog box appears.

In this dialog box, you must enter item ID data as required or specify the item to which the part file must be
linked.

If you select the Manual or Auto ID radio button and leave the Item ID: field blank, an item and an item ID is
generated in PLM. If you enter an ID in the Item ID:, an item is generated with the ID that you entered in the
Item ID: field. The Revision field is optional.

If you select the Manual ID radio button, you must enter an item ID in the Item ID: field. As a result, PLM
generates an item with the ID that you entered in the Item ID: field.

If you select the Existing radio button, you must specify an item ID in the Item ID field. This ID and revision
must match the Item that is existing in PLM Database.

If you entered incorrect item ID data in the Link to Item dialog box, before you save to PLM, you can click this
menu option again to correct the item data.

After you enter the ID data as required, you must save the part file to PLM.

Note that the properties set in the PLM Integration Properties for Integration dialog box determine which
item data you can specify in the Link to Item dialog box. For further information, see Initial Save Option on
page 99.
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Link Item to More than one Document
If the preferences specify that no items must be generated for part files on initial save to PLM, you must use
the Link to Item option from the PLM menu to create items for the part file that you are working on, or to link
the part file to an existing item in the PLM database.

If you click this option, the Link to Item dialog box is displayed.

During the Save to PLM and when you use the PLM menu option Link to Item, you can specify if the document
must update the BOM structure or not.

When you click Save To PLM:

• If a user saves a file with preference Set object to match filename selected, and the filename is matching
an existing item id, then the following message is

displayed.
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• If a user saves a file with preference Set object to match filename selected and links the existing item in
the Set Attributes screen and the item is already linked to another document, the following message is

displayed:
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Chapter 8: Saving and Unlocking Files

If a file that you are working on is supposed to be used in a business process, the business process cannot be
launched while the file is locked. To avoid this situation, you should save such files using the Save and Unlock
command. This automatically updates your data, while relinquishing ownership of the file. The business
process can then proceed.

If you have finished working on a file and the file must be passed on to an unknown new user, you should
also use the Save and Unlock command. The new user who needs to work on the file can now acquire ownership
of the file. If you know who will be the new owner of the file, you can transfer ownership to the new owner.
See Changing the ownership of a file on page 32.

To save and unlock a file:

• Select Save and Unlock from the PLM menu.

The file is saved in PLM with no owner. For further information on saving files to PLM, see Saving Files to PLM
on page 18.
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Chapter 9: Checking in a File

When you have finished working with a file, it can be vaulted. The PLM integration for SolidWorks enables
you to check in any SolidWorks file and its linked documents to the PLM vault.

The check-in operation accomplishes the following:

• Confirms the changes you made in the SolidWorks file.
• Changes the file’s status from Draft to RELEASED.
• Transfers the SolidWorks file to the PLM Released area from the users work area.

The integration verifies that you have authorization to perform this operation and that the document linked
to the file has the Draft status. If the file is new, the system prompts you with the Save As dialog box to save
the file locally and perform the check-in operation.

After the file has been checked in, the file can be modified only after check out. To check in a file:

1 Do one of the following:
• Click check in icon in the PLM toolbar.
• Select Check In from the PLM menu.

2 If prompted to save locally, save the file to SolidWorks first. The file is checked in.
You can specify how to handle files after they have been checked in. See Integration Preferences.
Note: If you check in a parent assembly, components that were checked out individually, and that belong
to sub-assemblies of the parent assembly, are not checked in.
For example, the situation is as follows:
• Parent assembly is RELEASED.
• Sub-assembly is RELEASED.
• Child of sub-assembly is RELEASED.
The user does the following:
• Checks out the parent assembly.
• Checks out the child of the sub-assembly and make changes.
• Checks in the parent assembly.
As a result, only the parent assembly is checked in. The child of the subassembly is not checked in because
the sub-assembly was never checked out and was therefore released at the time the parent assembly
was checked in.
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Check-in related drawing files
When user performs Check-In operation on a Drawing, the integration will Check-in its related model. Also,
if Check-in operation is performed on a model, the integration will Check-in its related drawings.

To enable this functionality, PLM Administrator needs to set the Projects’ Vault Parameter in Project
Configuration (pdadm3101s000)

session.
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Chapter 10: Checking out a File

You must check a file out of the vault in order to change it. The Check Out option is available after the file has
been retrieved from PLM tool.

To check out the file, you need to open it for editing in the integration. The file is opened in read-only mode
and cannot be modified until it is checked out. If you try to perform any modification in it, you will be prompted
to check it out first. This is done to protect the integrity of your data.

Types of check out:

Check Out Minor
This option is usually used for minor design revision changes. A minor check-out results in a higher sequence
number within the current revision for the checked out file, for example fromA0001 to A0002.

Check Out Major
This option is usually used for significant changes with major impact on the form, fit or functionality of the
product. A major check-out results in a higher version number for the checked out file, for example from
A0001 to B0001.

To check out a file:

• Select the assembly or component part that you want to check out and select Check Out from:
• The PLM Toolbar
• The PLM menu
• The right-click menu available on the objects in the design tree.

As a result, the assembly or component part is checked out. After the check-out, the file is no longer in read-only
mode and can be modified as required.

Check-out related drawing files
When user performs check-out operation on a drawing file, the integration will check-out its related model.
Also, if check-out operation is performed on a model, the integration will check-out its related drawings.
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To enable this functionality, PLM Administrator needs to set the Projects’ Vault Parameter in Project
Configuration (pdadm3101s000)

session.

Note: 

• Limitations
• Drawing must contain views of only one Model. But, if the drawing contains views of multiple models,

then the check-out operation from one Model will not impact the other Models.
• The integration user can check-out only the latest revision of the document. If a user wants to

check-out previous revisions of any document, that can be done from the PLM Client. In this case
the user must perform the Edit File after performing the check-out from the PLM Client.
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Chapter 11: Taking Ownership

While working on a large assembly, you may need to update a particular part. To prevent other users from
making changes to this part simultaneously, you must take ownership of the file.

To take ownership of a file within an assembly:

1 In the SolidWorks Feature Manager, select the part of which you want to take ownership.
2 Do one of the following:

• Click save and unlock icon in the PLM toolbar.
• In the PLM menu, select Take Ownership.
As a result, you are the owner and the file is locked for other users.
Note: When Take Ownership during Edit File preference check box is not selected, the users do not
take the ownership of the files even when they execute Edit File command.

Changing the ownership of a file
The owner of a file is determined by one of the following:

• The user who created it and saved it to PLM.
• The user who checked it out of PLM.
• The user to whom the ownership has been transferred.
• The user who performs the Edit File process on a saved and unlocked file.
• Project administrators are not the owners of all files, but they are given access to modify the files owned

by users in their projects

When you are registered as the owner of a file in PLM, you can edit the file as required, while other users can
view but not modify the file. You can choose to transfer the ownership to another user when the user needs
to work on that file.

Note: Ownership can only be changed if the file has been saved to PLM.

After a file has been checked in (and has RELEASED status), it does not have a specific owner. You cannot
change the ownership of a file with RELEASED status.

To change the ownership of a file:

1 In SolidWorks, for the part file with which you are working, select Change Ownership in PLM menu or
toolbar.
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2 In the Select User dialog box that appears, select the user you want to transfer the ownership to and click
OK. The selected user now owns the file.
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Chapter 12: Viewing PLM Data

While working on a SolidWorks file that already exists in PLM, you may want to look into the PLM data related
to the file and its components.

In SolidWorks, to view the relevant PLM data, proceed as follows:

1 On the PLM menu, select Show Meta Data. The Set Object Attributes dialog box is displayed. The default
tab, File, displays the PLM data of all the files that are part of your SolidWorks structure.

2 Click the Document tab to display the PLM document data related to your SolidWorks part

file.
3 Click the Item tab to display the PLM Item data related to your SolidWorks

files.

Assigning Mapping Template
Mapping template can be associated to SolidWorks files. The files is either already available in PLM or yet to
be saved to PLM. You can assign a mapping template using the Associate Mapping Template menu.
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Click the File tab on the Show Meta screen. View the template in the Mapping Rules

field.
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Chapter 13: Opening a file in PLM

You can open a part file directly from the integration in a PLM item or document pane. To open a document
in a PLM:

1 In the SolidWorks Feature Manager, select the root object.
2 Select Show Document Structure icon or Show Item Structure icon in the PLM menu or toolbar. The

document is opened in the appropriate PLM structure. The Document Structure displays the document
that was created in PLM. The Item Structure displays the items created for that

document.
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Chapter 14: Using Infocards

An infocard is a dialog box that enables you to update meta data of items, documents or files generated from
part files created in SolidWorks. There are three types of infocards, one for items, one for documents, and
one for files. You must use infocards to make changes to the attributes of item, document or file from
SolidWorks rather than in PLM. You can update only those items, document, or files that you own.

To update items, documents or files generated from the SolidWorks object that you are working on, proceed
as follows:

1 Select either an assembly or a part from the SolidWorks Feature Manager Design Tree.
2 From the PLM main menu or the right-click menu, select the relevant update option. You can select

Update Item, Update Document or Update File. As a result, the relevant pane is opened in Web PLM.
3 Make the required changes.
4 Click Save.

You can update the meta data of a file using the Details pane.
Note: To update a component of an assembly, in SolidWorks, open the Assembly Navigator and
double-click one of the components. The title bar displays the selected component-assembly relationship.
To open the infocard, select Update Item, Update Document, or Update File from the PLM menu.
If the part file whose item, document or file you want to update is not saved to PLM, a message appears
informing you that the selected part does not exist in the PLM database.
If the part file is not editable because you have no editing rights, the part file is locked by another user,
or because the object is released, the infocard dialog box appears in display only mode.
If you select Update Item, but no item is created for the part file with which you are working, the following
error message appears:
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The file [filename] you have selected is not associated with an Item in PLM.
This occurs if your preferences specify that no PLM items must be created for the part files that you save
to PLM
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Chapter 15: Synchronize Headers

Header information is the PLM data that is stored in your local environment. This information is used by the
PLM Integration for SolidWorks to verify whether a specific local file can safely overwrite the PLM file. The
Synchronize Headers operation updates the headers of the SolidWorks files currently opened with the relevant
PLM information.

If you are using PLM data to be displayed in your title box drawings, Synchronize Headers retrieves the latest
data to be displayed. If you receive a file from an external developer, and you must replace the PLM file with
the new file, you can use Synchronize Headers to identify the local file. In this case the PLM file will be
overwritten by the local file while saving to PLM.

When you click Synchronize Headers, the PLM Integration compares the metadata (version, revision and
status) in the local system with the metadata of the file in the PLM database. In case the PLM Integration
detects a discrepancy in the metadata of the files compared, the following Resolve File Identity screen is

displayed:

By default, the PLM Integration displays only latest revisions / versions of the file. The PLM Integration selects
the most recent revision / version.

The name of the file.File ID

The version of the file.Version

The name of the file.File Name

The permission to overwrite the file.Overwrite File

The ID of the project in which the file is saved
presently.

Project ID

The ID of the entity which locked the file.Locked By

The application which created the file.Originating App

The ID of the document linked to the application.Document ID

The present revision number of the file.Revision

The present status of the file.Status
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The description of the file.Description

The date from which the file is effective.Effective From

The date to which the file is effective.Effective To

The business process ID of the file.Business Process ID

Displays all the available revisions of the file.Show All Revisions

The name of the present project in which the file is
saved. In case you select a new project, the PLM In-
tegration automatically selects the option Create
New File During Save.

Select Project

Saves the selected file in the local system.Save

Prints the selected file.Print

Synchronizes the Local storage with the data stored
in PLM.

OK

Stops the synchronization process.Cancel

The following are the salient features of the Synchronize Headers process:

• All the files are displayed in a single screen.
• By default the selected records are synchronized to the latest revision in PLM. Users can select or deselect

the files displayed.
• By default only the latest revisions are displayed. Select Show All Revisions to view all the revision for

the project.
• You can change the project and synchronize the data from the selected project.
• You can save all the data displayed in the Resolve File Identity screen or only the selected data.
• By default the file is saved in the Edit location with the name as <RootFileName.extn>_<date>_<time>.

txt.
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Chapter 16: Clear Storage Information

Clears the storage information for the active/selected file and its dependents. When you click Clear Storage
Information:

• Clears the data for the active/selected file and its dependents from the storage data tables. The Infor
PLM treats the part as new. The Clear Storage Information functionality is designed to enable the user
to quickly save the active/selected.
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Chapter 17: Delete Local Files

Use the PLM menu option Delete Local Files icon to delete the selected local files. PLM also clears the
information about the deleted files from the storage files.

The CAD Integration: Delete Files screen displays the files that are registered in the storage files and saved in
the local system. By default, the files are selected for

deletion.

When you click Delete, PLM prompts you to confirm the file

deletion.

Click Yes to delete the selected local files. PLM also clears the information about the deleted files from the
storage files.

Note: You cannot delete the files that are open. The selection box for the open files is disabled.
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Chapter 18: Refresh Files from PLM

You can click Refresh files from PLM icon to update the currently open files from Infor PLM.

Note:  Refresh files from PLM is only applicable for the files present in Edit/View directories.
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Chapter 19: Design Variants

The Capture Design Variants feature enables you to automatically or manually link items to design variants
or configurations for parts and assemblies.

Managing design variants/ configurations
To capture configurations and manage the links between model configurations and PLM items, select Capture
Design Variants from the PLM menu. The PLM Select Design Variants dialog box is

displayed.

In this dialog box, you can define how each configuration must be linked to an Item. To select configurations,
select the check boxes of the configurations to be linked or select the Select All checkbox. The data that you
define in this dialog box are saved locally, until you save the items linked to the configurations to PLM.

Note: Item IDs can be set as CAD Instance Name. For more information, refer to "Set CAD Instance Name as
Item-ID" on page 125.

Generate Items for all Configurations
If this check box is selected, in PLM preferences, items for all the configurations are generated and linked to
document in PLM when you perform the Save to PLM operation, regardless whether Capture Design Variants
steps are performed or

not.
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Linking configuration to existing item
To link a configuration to an item present in PLM, proceed as follows:

1 Select the line with the required configuration.
2 Click Link Item. The PLM Set Object Properties dialog box is

displayed.
3 Select Existing.
4 Specify the item ID and the revision number in the Item ID and Revision fields.
5 Click OK. If you save the linked items to PLM, the configuration data is also stored in PLM.

Automatically create item for configuration
If item IDs are automatically created according to the preference settings, in the PLM Select Design Variants
dialog box, just select the required configuration. When you save the file to PLM, the item for the configuration
is automatically created. For further information on preference settings, see Integration Preferences.

Manually create item for configuration
If item IDs are manually created according to the preference settings, to create an item for a configuration:

1 Select the line with the required configuration.
2 Click Link Item. The PLM Set Object Properties dialog box

appears.
3 Specify the Item ID.
4 To have PLM define the first revision, click Manual or Auto ID.
5 Click OK.
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As a result, the PLM Select Design Variants dialog box shows the details of the existing item with the link

to the configuration.
If you click OK in the PLM Select Design Variants, the data is saved locally. If you save the linked item to
PLM, the linked configuration data is also stored in the PLM database.
After saving the data locally or to the PLM database, you can use the PLM Select Design Variants dialog
box to view the links between the model configurations and the PLM items.

Best practices
To change or update design variants in the CAD application, do not manually update the SolidWorks Design
Table (the internal Excel table). The reason is, that the Design Table includes details that are also stored in
the PLM items associated with the design variants.

Such updates must be performed in PLM. For example, to remove a design variant, you must unlink the variant
item from the related document. When the variant is next opened in SolidWorks from PLM, you are prompted
about the changes.

To modify any SolidWorks configuration, including the Default name, use the SolidWorks Configuration
Manager tab. When you save to PLM after modifying the configuration, the related item's CAD instance name
attribute will be updated.

Note: Configuration name modifications to the Default name must never be performed using the SolidWorks
Design Table (the internal Excel file). Using the SolidWorks Design Table for this purpose results in the creation
of an additional, redundant configuration.
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Chapter 20: Associative Links

SolidWorks part or an assembly can be dependent on another part or assembly for its design. The associative
links functionality, saves the associations between the SolidWorks files and PLM when you perform the Save
to PLM operation. To actualize this functionality, the Reference Links tab is included in the Set Attributes

dialog box.

Edit file
When you download a SolidWorks file (Part or Assembly), all the drivers and the impacted files associated
with the SolidWorks file are also downloaded. These files are listed in the download

manager.

Check-In
When you perform a Check-In operation on a file from the Integration or from the PLM, the application
check-in all the drivers of the file.
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Check-out
When you perform the Check-Out operation on a file from the Integration, the application checkouts all the
impacted files.

Integration Preference
To enable the associative links functionality, you must enable the Save External References check box, in
General tab of the Solidworks Preference session.
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Chapter 21: Dispatch to business process

The Dispatch to Business Process option on the PLM menu enables you to link the PLM items and/ or
documents, which are generated for a SolidWorks file, to a PLM business process. As a result, PLM items
and/or documents of SolidWorks file are linked to a workflow, which is distributed to the users associated to
the workflow template.

For further information, see Attach to Workflow on page 108.

Dispatching documents and/or items to a business process
To dispatch documents and/or items to a business process, complete the following steps:

1 Select PLM > Preferences..... The Integration Preference screen is displayed.
2 In the Attached to Business Process field located under the Attached to Workflow category, select the

PLM objects that can be dispatched to the business process. For further information, see Dispatch items
to a business process.

3 Click OK.
4 In the SolidWorks application, save the file to PLM.
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5 Click Dispatch to Business Process on the PLM menu. The Business Process Details screen is

displayed.
6 Specify the business process data and select a workflow template.
7 Click Save. The business process launches after you save the template.

Dispatching related models or drawings
You can attach drawings of a model file to the business process. The model files are either part files or assembly
files. To dispatch a drawing to the business process, enable the Attached related Models\Drawings check box.
When you dispatch a model file to the business process, the drawings and the PLM objects of the models are
linked to the same business process.

If you dispatch a model file to the business process, related drawings are attached to the business process,
to which the models are linked. Similarly, if you dispatch a drawing file to the business process, related models
are attached to the business process, to which the drawings are linked.

To dispatch drawings to a business process

1 Select PLM > Preferences..... The Integration Preference screen is displayed.
2 Select the Attached related Models\Drawings check box located under the Attached to Workflow

category.
3 Click Ok.
4 In the SolidWorks application, save the file to PLM.

Infor PLM for Discrete SolidWorks User Guide | 50

 

Dispatch to business process



5 Click Dispatch to Business Process on the PLM

menu.
6 Click Yes. The Business Process Details pane is

displayed.
7 Specify the business process data and select a workflow template.

8 Click Save icon.
9 To save and unlock the file, click Yes or click No. On a successful completion of the business process,

confirmation message is displayed.
Note: 
• Save all the drawing attached to the model file, before you dispatch a model file to a business process.
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• Ensure that the model files and the drawing files are open in SolidWorks, before you dispatch the
model file to business process.

Controlling Locked Objects
If you select a value for Action for Objects locked by Business Process in Integration Properties for
Integration, it controls the behavior of the integration when the objects that are part of current business
process are locked.

The following screen shows the options in Attached to Work Flow preference for

Solidworks.

These options are available for Action for Objects locked by Business Process:

Attached as Unlock
If any object is locked by any other business process, then integration will attach that object to the newly
created Business Process without taking lock for that object.

Do not attach
If any object is locked by any other business process, then integration will not attach that object to the newly
created Business Process.

Cancel action
If the object is locked by any other business process, then integration will cancel the current dispatch to
Business Process operation.

Always attached as Unlock
All the objects are attached to the newly created Business Process without taking lock for any of the objects.

Troubleshooting Scenarios
• The drawing file is missing on the local system:

If you dispatch a model file to a business process when the related drawings are deleted from the local
system, the warning message is displayed.
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• The local version of drawing different from the version linked to the model in PLM.
• Drawing file not open in SolidWorks Application:

If you dispatch a model file to a business process when the related drawings are not open in SolidWorks
application, a warning is displayed.
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Chapter 22: Saving Modified Files Only

Generally, the Save to PLM process performs the operation on all the editable files within the structure of
current file and transfers all these editable files to PLM. However, it is possible that one or more files within
the structure of the current file are unchanged even though they are editable; therefore, it is not required to
save them into PLM. To save only the modified files, enable the Save only modified files integration preference.
The Save only modified files preference is made available in the Save Changes to PLM

property.

You can also enable or disable the Save only modified files from the add-in

toolbar.

The first button, when enabled indicates that the integration preference Save only modified files is enabled.
To disable the preference, click the

button.

The second button, when enabled indicates that the integration preference Save only modified files is
disabled. To enable the preference, click the

button.

For Example,

In the following structure:

Assume that all files A1, SA1, SA2, P1, P2, P3 and P4 are new. Normally, when you perform Save to PLM for
assembly A1, all the files are saved to PLM.
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Now, assume that you have made changes to MA, SA1 and P1 files in the A1

assembly:

When you perform the Save to PLM operation on the above file structure, not only the changed files, even the
unmodified files are also saved to PLM. However when you enable the Save only modified files preference,
only MA, SA1 and P1 files of the A1 assembly are saved to PLM.

Important Points and Limitations
These are the limitations and important points to be considered for Saving modified files only preference:

• The Save only modified files preference is applicable only for Save to PLM operation and is not applicable
for Save and Unlock and Check-In operations. The reason being that if the files contain mapping, then
even if the files are unchanged, still the Save and Unlock and the Check-In operations might modify the
files as a result of the mapping definitions.

• Operations such as Link to Item, Capture Design Variants, Associate/Remove Mapping Template mark
the file as locally modified. Therefore, you must save the files to PLM.

• During Save to PLM operation, if you take ownership of any file, then those files must also be saved to
PLM.

• Changing/setting the values of any of the integration preference values does not consider the file to be
requiring saving into PLM. Example setting/changing of neutral file generation options, setting thumbnail
generation preferences, usage of preference Generate items for all configurations and so on, is not
considered for treating the file as requiring saving into PLM.

• If a model/assembly is changed, and user performs Save to PLM from the model and the Save only
modified files check box is selected, then it is assumed that the associated drawing must also be saved
to PLM. In the dialog PLM - Select Parents to Save to PLM, system will list the drawings for only those
models that are changed and require saving into PLM.

Integration Preferences to Save Changes to PLM
Use the Save Changes to PLM property to control the aspects related to saving the SolidWorks files to PLM.

The Save Changes to PLM property comprises of the following options:

• Save only modified files
• Warn if the selected document is changed but not locally saved
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• Do not traverse child files under non-modified files

Save only modified files
If this check box is selected, only the modified files are saved to PLM when you perform the Save to PLM
operation.

The Save only modified files preference is applicable only for Save to PLM operation and is not applicable
for Save and Unlock and Check-In operations. The reason being that if the files contain mapping, then even
if the files are unchanged, still the Save and Unlock and the Check-In operations might modify the files as a
result of the mapping definitions.

Warn if the selected document is changed but not locally saved
If this check box is selected, when you perform the Save to PLM operation on a document, which is modified
in the application session, then you will be prompted to save the file on a local system and then try Save to
PLM.

If this check box is cleared, you are not prompted to save the file on a local system, the Save to PLM process
is executed. However, it is suggested that you save the file on a local system before saving it to PLM, when
Save only modified files option is enabled.

Do not traverse the child files under non-modified files
If this check box is selected, the child files attached to the unmodified files are not traversed. By default, the
entire structure is checked for the editable files. If this preference is enabled, integration will not traverse
CAD files for children under the sub-structure of non-modified files. Enabling this preference improves the
performance and minimizes application memory usage. It shall be noted that, then even if this preference is
checked, integration will still look for the modified child files (within the structure that are tagged as modified)
by using the information under Toolkit local storage (StorageTableChildren.txt).

In order to know which files within the structure are modified and requires saving to PLM, integration traverse
the structure of the CAD file downwards (within the CAD Tree). This causes loading of the files(even if those
files require saving into PLM or not).

For Example, Consider below structure:

For example, in the above case, when you perform Save to PLM operation for A1.sldasm, the filesA3.sldasm
and P4.sldprt are also loaded into application memory (even though these files are not transferred to PLM,
and are unchanged).
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When Do not traverse child files under non-modified files is enabled, integration does not traverse downwards
within the structure of the non-modified files.

There are situations where one of the child file is changed, but its parent is not changed.

For Example,

In this case, if the Do not traverse child files under non-modified files is enabled, then although integration
will not traverse downward within the structure of non-modified files to find out the child files that are
changed. However, the integration can identify the file P7.sldprt under the structure as requiring saving into
PLM. This is possible by using the information from Toolkit storage file %CFE_CLIENT_ HOME%\Tookit\data\
StorageTableChildren.txt.
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Chapter 23: General Mapping

General mapping enables you to define attribute-based mapping rules for a template. When you create parts,
assemblies, or drawings in SolidWorks using a template, the mapping rules are carried over to the parts,
assemblies, or drawings based on how you set up the rules.

The mapping rules determine how values of SolidWorks attributes are mapped to PLM attributes and vice
versa for part files that use the template containing the mapping rules.

In SolidWorks, create template Template_1. For Template_1, define the following mapping rule: SolidWorks
attribute Weight goes to PLM item attribute Estimated Weight.
Save Template_1 as part file A0001. As a result, the value calculated for the Weight attribute of part file A0001
is mapped to the Estimated Weight field of the item that is created when you save part file A0001 to PLM.
For any following part files for which you need the mapping rules defined in Template_1, open
Template_1 and save Template_1 under the desired part file name.
Note: To use general mapping, you must have administrator's rights.

Creating the Template
To use general mapping, templates must exist for which mapping rules have been defined. You can only
create mapping rules if you have administrator’s rights.

To create a template and define mapping rules for the template, proceed as follows:

1 In SolidWorks, select File > New to create a new template file.
2 Specify the attribute properties to be mapped to PLM for the template.
3 Click OK.
4 Open the template in the SolidWorks.

Note: To change the properties of a template, open the template file, adjust the properties, and save the
template file.
For general mapping to work, make sure that the assemblies, parts, and drawings that you use as templates
for general mapping are stored in the <SolidWorks installation path>\Solid Works\data\templates
folder.
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Opening the template in SolidWorks
1 In SolidWorks, from the PLM menu, click Use Mapping Template tool. The PLM Mapping Tool dialog box

is displayed.
2 Select SolidWorks in the Application field.
3 In the Template list, select the template for which you want to define mapping rules.

If the template is new or if changes were made to the template in the CAD application, you must import
the template into PLM first. For further information, see Importing the template into PLM on page 59.
Any previously defined mapping rules for the selected template are displayed in the dialog box.

Importing the template into PLM
Before you can define mapping rules for new or changed templates, you must import them in PLM. Re-importing
a template will not remove any previously defined rules for this template.

To import a template:

1 From the Application list in the upper left of the PLM Mapping Tool dialog box, select SolidWorks.
2 Click Import.
3 In the Open dialog box that appears, select the template for which you want to define mapping rules and

click Open.
As a result, the template properties are displayed in the upper right section of the PLM Mapping Tool
dialog box.
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Defining the mapping rules
In the PLM Mapping Tool dialog box, you can define the mapping rules that are used to map attributes between
PLM and SolidWorks. This dialog box is divided into two sections, one for the PLM attributes and one for the
SolidWorks attributes.

To map SolidWorks attributes to PLM attributes and vice versa.

To map, for example, the value of the Author attribute in the Summary groups in SolidWorks to the Description
attribute of an item from PLM, proceed as follows:

1 Click the Item icon on the left side of the PLM Mapping Tool dialog box.
A list of item attributes is displayed on the left side of the middle section of the screen.

2 From the list of item attributes, click Description from the list.
3 From the SolidWorks side of the window, click Summary.

A list of attributes is displayed.

4 Click Author from the list of attributes.
5 Click the To PLM button in the middle section of the dialog box. This maps the value of the Author

attribute to the Description attribute of the item in PLM.
You can add more mapping rules before accepting them. See Mapping options on page 60 for further
information on the available mapping options.

6 When you are through specifying mapping rules, click Apply.
7 Click OK to exit the PLM Mapping Tool dialog box.
8 For the mapping rules to take effect, in the PLM client, disconnect and then reconnect to the server.

Mapping options
There are countless variations of the attributes you can map. You can select an attribute associated with an
object in PLM and map it to an attribute in SolidWorks or you can reverse the direction and map an attribute
value in SolidWorks to an object’s attribute in PLM.

For this purpose, make selections from the PLM and SolidWorks sections and click the button that describes
the direction you want the mapping to take place.

• The To CAD button maps the selected attributes from PLM to SolidWorks.
• The To PLM button maps the selected attributes from SolidWorks to PLM.
• The Both button maps the selection to both PLM and SolidWorks. This mapping rule goes in both

directions, which means the values remain in sync.
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In SolidWorks, if you are working with a part file and you enter a value for an attribute that is mapped to both,
the following dialog box appears when you save the part file to

PLM.

This dialog box prompts you to indicate which value you want to keep the value just entered in SolidWorks
or the value entered in PLM.

Note: Depending on the selected type of attribute, the To CAD, To PLM, and/or Both buttons can be
unavailable. For more information on mapping restrictions. See Mapping restrictions on page 61.

You can map one SolidWorks attribute to one PLM attribute, one SolidWorks attribute to many PLM attributes,
or many SolidWorks attributes to one PLM attribute.

For example, if you mapped a second SolidWorks attribute, to the item’s description in PLM and you save to
PLM, the value of the item’s description in PLM will be the two values you mapped from the Author and Date
attributes in SolidWorks separated by a comma.

Note: You cannot map more than one attribute to a target attribute in a format other than string. If you do,
the system regards the two or more concatenated values (separated by a comma) that are mapped to the
target attribute as one value in string format and thus generates an error message. For example, map the
values of the Mass Properties field and the Mass Properties field of the Configuration Specific group, which
are in double format, to the Estimated Weight field of an item in PLM, which is also in double format. As a
result, when mapping is performed, an error message appears informing you that the mapped values must
be in double format.

Mapping restrictions
Depending on the attributes selected in the PLM Mapping Tool dialog box, mapping to PLM, to SolidWorks,
or both can be unavailable. The mapping restrictions are described in the following sections. Attributes not
included in the following lists are available for mapping to PLM, SolidWorks, and to both. For all mapping
rules that you want to define, the target attribute must be a modifiable field.

The following PLM attributes are only available for mapping from PLM to SolidWorks:

• PLM Effectie From
• PLM Effetive To
• Item:

Lifecycle
All attributes related to an item's life.
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Business Process
The attributes related to an item business process or a business process.

Keywords
Keyword attributes.

Business Partner
Manufacturer, supplier, customer, and subcontractor attributes.

• Document:

Lifecycle
All attributes related to an item's life.

Business Process
The attributes related to an item business process or a business process.

Keywords
Keyword attributes.

Project
All project attributes.

Attribute format restrictions
To enable you to define mapping rules, the PLM attributes and the SolidWorks attributes must have the same
format or must have a conversion in order to facilitate the following matches:

Table 1: Attribute formats

RealDateIntegerStringTo:From:

+String

+ (*)+ (*)+Integer

+ (*)+Date

+ (*)+Real

+ (*) According to regional settings.

The target attribute must be of type string if more than one attribute is mapped to this attribute. The target
PLM attribute to which SolidWorks dimensions are mapped is of type string, because the value and the unit
must be concatenated to a string. The target PLM attribute in a SolidWorks file-specific rule can have no other
general mapping.

SolidWorks
Attributes from the SolidWorks Configuration Specific group can only be mapped to PLM item attributes.
The reason is, because configuration specific attributes have different values for each configuration, these
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values must be mapped to the item representing a particular configuration and not to the document that
describes all configurations for a particular assembly.

Relationships
You can map one SolidWorks attribute to one PLM attribute, one SolidWorks attribute to many PLM attributes,
or many SolidWorks attributes to one PLM attribute.

Associating the mapping rules to part files, assemblies,
or drawings
Now that you have created mapping rules and saved them to a template, you can create parts, assemblies,
or drawings in SolidWorks using this new template. The part, assembly, or drawing acquires the values of the
attributes you defined in the mapping rules. Only the owner of a file or the project administrator can perform
associations.

To associate mapping rules to a file:

1 In SolidWorks, open a template file for which you have created mapping rules from the <Solid Works
installation path>\SolidWorks\data\templates folder as described in the previous sections

2 Save the template file under another name (that is, under the name of the part, drawing, or assembly
that you are going to work on and to which you want the mapping rules of the template to apply). As a
result, the new part file (or drawing or assembly, as the case may be) has obtained the attributes and the
mapping rules of the template.

3 Save the part file with the new name to PLM.

The Associate Mapping Rules menu option
In addition to the methods described in Associating the mapping rules to part files, assemblies, or drawings,
you can use the Associate Mapping Rules option from the PLM menu to associate mapping rules to files.
Note that you can only use this option for files not associated to a mapping template previously by opening
the template and saving the file under another name.

To associate a file to a template using the Associate Mapping Rules option, proceed as follows:

1 In SolidWorks, open the file for which you want to associate mapping rules.
2 Click PLM > Mapping > Associate Template.
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The PLM Discrete Mapping Tool dialog box is displayed in the

PLM.

3 From the Template list, select a template you created in SolidWorks. The mapping rules for this template
are displayed.

4 Click OK.
The mapping is completed when you save to PLM.
After the mapping rules are associated, you can click Display Mapping from the PLM menu to display
the current mapping rules.

Removing mapping associations
You can remove the rules that are associated with the template. For this purpose, select Remove Association
from the PLM menu. Only project administrators who own the file can remove an association. If you remove
an association, any file-specific mapping rules are kept.

Using configuration-specific mapping
For each template, you can define mapping rules for attributes that only relate to a specific configuration.
Mapping can take place between the parts and the PLM items.

To perform configuration-specific mapping, proceed as follows:

1 Define a mapping rule using a configuration-specific attribute in SolidWorks. For this purpose, on the
PLM Mapping Tool dialog box, select Configuration-specific under the SolidWorks section.

2 Define a rule to map, for example, map the value Mass in the Mass properties in SolidWorks to the item’s
Estimated Weight in PLM.
Note that users must avoid defining configuration-specific mapping for the following attributes:
• Item_ID
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• Revision
• Status
These attributes are used to create design variants and serve as links between design variant instances
and PLM items. For further information, see Managing design variants/configurations.

3 Create a file in SolidWorks.
4 Specify configurations. For example, specify a value for Mass.
5 Capture the design variants for the configuration. For further information, see Managing design

variants/configurations.
This procedure is applicable for all parts, assemblies and drawings. The mapping groups may be different
for these components. The mapping groups are listed in the following table.

DrawingsAssembliesParts

SummarySummarySummary

Custom PropertiesCustom PropertiesCustom Properties

Notes

Material Properties

Sketch DimensionsConfiguration-specific Proper-
ties

Configuration-specific Proper-
ties

BlocksNotesNotes

Specific AttributesSpecific Attributes

Feature DimensionsFeature Dimensions

Display Mapping
You can use the Display Mapping option in the PLM menu to view the general or file-specific mapping rules
defined for the template associated to the part file with which you are working. If you click this option, the
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PLM Mapping Tool dialog box appears in view-only mode showing the associated template and the mapping

rules.

Applying the mapping rules
For the mapping rules to take effect after you define or update them in the Web PLM as described previously,
you must first disconnect and reconnect your CAD application to PLM.

The mapping then takes place depending on the rules that you set up. In the example in "Defining the mapping
rules" on page 69, the mapping takes place when you:

• Save to PLM.
If the file is new and has not been saved to PLM, you must save the file to PLM to apply the mapping. Once
the mapping is applied, you can select Update Item, Update Document or Update File from the PLM menu
to see the mapped values. For further information, see "Using infocards" on page 41.

• Use the infocard options:
• Update Item
• Update Document
• Update File

• Edit the files.
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Chapter 24: Save Neutral Files Option

Use this option to specify an additional format to save the local SolidWorks files to PLM. As a result, if you
save a part file to PLM, the part file is also saved in the additional format. The additional file is used for viewing

To enable the additional save, select the check box for the required file type and the radio button for the
required format.

You can define formats for the following types of SolidWorks files:

• Parts
• Assemblies
• Drawings

Following properties are relevant to the neutral files:

• Generate Neutral Files
• Show Neutral files during save

If this check box is selected, the information about the Neutral Files is displayed in the Set Attributes dialog
box, before you save the files to PLM.

Location of generating neutral files
By default, the neutral files are created in the %TMP%/NeutralFiles or <PLM_Client>\Solid Works\Neutral
Files folder . However, you can change the folder location by specifying the new folder path in the environment

variable.

If you set the environment variables as shown above, the neutral files are created in C:\PLM_ NEUTRAL_FILE_
DIR. Ensure that no other files are manually created in the folder, because the files in the folder are deleted
when you close SolidWorks.
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Generate neutral files during
Specify during what actions the neutral files should be generated. Available options are:

On All Actions
Neutral files will be generated during Save to PLM, Save and Unlock and Check-In actions.

On Save and Unlock
Neutral files will be generated only during Save and Unlock.

On Check-In
Neutral files will be generated only during Check-In.

Save Neutral Files Parts
Specify the different formats in which neutral files are to be generated; applicable for part files. The supported
formats to generate neutral files:

• BMP
• PDF
• IGES
• ParaSolid
• ACIS
• Stereo Lithography

Save Neutral Files Drawing
Specify the different formats in which neutral files are to be generated; applicable for drawing files. The
supported formats to generate neutral files:

• BMP
• PDF
• DWG Format
• DXF Format

Save Neutral Files Assembly
Specify the different formats in which neutral files are to be generated; applicable for assembly files. The
supported formats to generate neutral files:
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• BMP
• PDF
• ParaSolid
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Chapter 25: Thumbnails

Thumbnail is a miniature representation of a SolidWorks part, assembly or a drawing. Solidworks integration
generates the thumbnails in the JPEG or PNG format.

Thumbnails can be generated in the following ways:

• During the Save to PLM, thumbnails are created for editable files.
• Using the Generate Thumbnails option on the PLM menu, users can create thumbnails for the non-editable

files in the structure.

Generating Thumbnails
To generate thumbnails for editable components, that is, to generate the thumbnails when you save the
SolidWorks file to PLM, complete the following steps:

1 In SolidWorks application, select PLM > Preferences the PLM Preferences for SolidWorks pane is displayed.
2 Select the Generate thumbnails during save to PLM check box located under the Thumbnails category.
3 Click OK.
4 Click Save to PLM on the toolbar.

Note: Thumbnails are generated only for the editable components, that is, components with status Draft,
and that are locked by you (current user). You can generate thumbnails for a SolidWorks file, only when
you have the ownership for the components.

Generate thumbnails for non-editable files
To generate thumbnails for SolidWorks files saved to PLM and for non-editable files, complete the following
steps:

1 Open the SolidWorks file. For further information on opening the files that are saved to PLM, see Editing
files in the integration.

2 Click on the toolbar.
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Thumbnail Locations
By default, thumbnails are saved in the %TMP%/ Thumbnails or %CFE_CLIENT_HOME_%\temp\ Thumbnails folder.
To change the folder, modify the variable value of the PLM_SW_THUMBNAIL_GEN_ DIR environment variable.

Note: Thumbnails are deleted from the local system when you close the SolidWorks application.

Thumbnails for Item Configurations
Thumbnails are generated for the default configuration, that is for the originating items, when the design
variants are not captured. The thumbnails are linked to the document.

For Example, In the following configuration PLM_Design_Variant is the default part configuration and Variant

1 and Variant 2 are the design variants.

The following table indicates SolidWorks parts linked to various design variants of the configuration:

Table 2:

ImageSolidWorks Configuration

Default (PLM_Config)

Variant1 (PLM_Config)

Variant2 (PLM_Config)
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Generate Thumbnail for Active Configuration
To generate the thumbnail of the active configuration, enable the Use Thumbnail Information of Active
Configuration check box in the PLM integration preferences. This scenario is valid when there is only one
item or no items linked to the file. When the Use Thumbnail Information of Active Configuration preference
is selected, thumbnails are not generated for the default configuration.

For Example,

In the following configuration PLM_Design_Variant is the default part configuration and Variant 1 and Variant

2 are the design variants.

When the Use Thumbnail Information of Active Configuration option is selected, the thumbnail is generated
for the active configuration, that is, Variant 2. However, if the option is not selected, a thumbnail for the
Default configuration is generated.

Integration Preferences for Thumbnails
The properties comprising the Thumbnails control the following aspects:

• SolidWorks files for which thumbnails can be generated.
• Format of the thumbnails.
• Level to which the thumbnails can be generated in a CAD structure.

The Thumbnails option includes the following properties:

• Generate thumbnails during Save to PLM on page 73
• Generate thumbnails for part file types on page 73
• Generate thumbnails for assembly file types on page 73
• Generate thumbnails for drawing file types on page 73
• Use thumbnail information of active configuration on page 73
• Generate thumbnails for CAD file structure on page 73
• Format for thumbnails generation on page 74
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Generate thumbnails during Save to PLM
If this check box is selected, thumbnails are generated when SolidWorks files are saved to PLM. This option
generates thumbnails only for the editable components of a SolidWorks file. A file is editable when the status
is Draft and you have the ownership of the file.

Generate thumbnails for part file types
If this check box is selected, thumbnails are generated for the SolidWorks part files, that is, files with .prt or
.sldprt extension.

Generate thumbnails for assembly file types
If this check box is selected, thumbnails are generated for the SolidWorks assembly files, that is, files with
.asm or .sldasm extension.

Generate thumbnails for drawing file types
If this check box is selected, thumbnails are generated for the SolidWorks drawing files, that is, files with.drw
or .slddrw extension.

Use thumbnail information of active configuration
If this check box is selected, thumbnails are generated for the active configuration of a part or an assembly.
For further information, see Generate Thumbnail for Active Configuration.

Generate thumbnails for CAD file structure
This preference is relevant only when you select the Generate Thumbnails... option from the PLM menu or
when you click button on the toolbar. Allowed values:

All Levels
Thumbnails are generated for the files linked the selected file.

Selected document only
Thumbnails are generated only for the selected document.
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Prompt
The Select files for Thumbnail Generation dialog box is displayed. To generate thumbnails for a particular
document, select the relevant check

box.

Format for thumbnails generation
Select the format in which the thumbnails must be generated. This field can have the following values:

• PNG
• JPG
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Chapter 26: Balloon Mapping

You can now transfer balloon numbers from SolidWorks to the part list table in PLM. This information can be
stored to any field of the Part List table, in addition to the Find No. field.

• Constraint on page 75
• Solution on page 75
• Assigning mapping template on page 76

Constraint
These are the constraints:

• Ballooning is done only for Top-Level components.
• When there exist multiple drawings in the system for the same [model + configuration], the information

in PLM is overwritten with the ballooning information of last saved document.
• If ballooning is not performed for a document, then the information in PLM is not updated.
• You must first create a Top-Level BOM Table and then perform automatic balloon creation.
• Only Balloon information linked to the top level Item is mapped.
• If balloons are mapped to the Find No. field in PLM, user is responsible to prevent duplicate numbers. In

case of duplicate Find No, an error message is displayed.

Solution
During Save to PLM, the Ballooning information for a particular [model + configuration] is retrieved from
various views across various sheets of a drawing. The ballooning information is read-only from the views that
are linked to BOM tables of type Top-Level.

Following points must be considered for this solution:

• The parent item [model + configuration] must either be captured in PLM or it is the default configuration
of that file. The views must be for this [model + configuration].

• If multiple views are linked to same BOM table, then the BOM information from all the views is retrieved.

Infor PLM for Discrete SolidWorks User Guide | 75

 

Balloon Mapping



• However, if there exist multiple BOM tables in the drawing for the same [model + configuration],then
integration will collect information only from those views that are linked to the same BOM table. That is,
integration will not mix the information of views linked to different BOM tables.
Example for a particular model “A1.sldasm” and Configuration “Default”, if there are 2 BOM tables (Bom_1
and Bom_2) and 4 views (View_1, View_2, View_3 and View_4). View_1 andView_2 are linked to Bom_1
and View_3 and View_4 are linked to Bom_2, and both the BOM tables are of type “Top-Level”. In this
case, the ballooning information from all views linked to BOM table “Bom_1” is retrieved. If no ballooning
information is found, then the ballooning information from all views linked to BOM table “Bom_2” is
retrieved. In any case, integration will not combine the ballooning information of views from two different
BOM tables.

• When multiple drawings exist for the same [model + configuration], ballooning information of the first
drawing is retrieved. If ballooning information is not found or if the ballooning information of the drawing
is incorrect, then ballooning information is retrieved from the next drawing. When the integration finds
the ballooning information in a particular drawing, it uses that for mapping the ballooning information.

• When capture design variant is not performed, the balloon-ids are retrieved in the following order:
• If the default configuration is also used within the assembly (as Top-Level component),then the

Balloon-id of default configuration is retrieved.
• If the default configuration is not used within the assembly as a Top-Level component, then the

Balloon-id of the non-default DV (that is, un-captured DV) that is in use is retrieved. For more
information, see Scenarios in Balloon Mapping.

• When multiple documents are linked to same item, the Balloon-id of the “BOM Defining”document is
given a priority. If both the documents are either “BOM Defining = True” or both are “BOM Defining
= False”, the Balloon-id of the document with the unresolved design configuration is retrieved. However,
when both the documents are using unresolved configurations or when both the documents are using
the resolved configurations, then integration will pick the Balloon-id of the first one in the collection (it
can be random, depending on how it is used in the assembly). See example scenarios for more details.

• When the target field in PLM is FIND_NO, then integration checks if the same balloon-id is specified for
two different child items. If the balloon-id is specified for two different child items, then the FIND_NO
field for the parent item is not updated (by using the ballooning data). Old values are retained for all the
child items of that parent item, because the field is unique in PLM.

Assigning mapping template
Mapping template can be associated to SolidWorks files. The files is either already available in PLM or yet to
be saved to PLM. To assign a mapping template, in the PLM menu select Associate Mapping Template. The
CAD Integration - Set Object Attributes screen is displayed.

Click the File tab. Select a template from the Mapping Rules list.
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Integration Preferences for Balloon Mapping
Use the Balloon Mapping property to control the transfer of balloon numbers from SolidWorks to the part
list table in PLM.

The Balloon Mapping property comprises of the following options:

• Transfer Ballooning Information on page 77
• Field in Part List Table on page 77
• Warn for duplicate Balloon IDs on page 77
• Warn for Incorrect Ballooning on page 77
• Apply Ballooning Values of non-default configuration to default configuration on page 77

Transfer Ballooning Information
If this check box is selected, it is possible to map ballooning information from CAD files to PLM.

Field in Part List Table
Specify the target field in PLM Part List table to which the Balloon information must be transferred. This field
name must match the database field name.

Warn for duplicate Balloon IDs
If this check box is selected, the user is alerted when two child items (of the same parent) item have the same
Balloon-id.

Warn for Incorrect Ballooning
If this check box is selected, the user is alerted if the Ballooning is not properly performed for the child
components (under a parent).

Apply Ballooning Values of non-default configuration to default
configuration
If this check box is selected, the balloon mapping values of the non standard configuration is applied to the
item of the main assembly assigned to the standard configuration.
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Scenarios in Balloon Mapping
The section explains various scenarios of mapping the ballooning information from CAD to PLM.

• Normal ballooning scenario on page 78
• When various design variants (configurations) are used on page 83
• Same item linked to multiple documents on page 86
• Multiple Views for the same [ model + configuration ] using the same BOM table on page 88
• Multiple BOM tables for the same [model + configuration] on page 89
• The Warn for Duplicate Balloon-Ids preference is enabled on page 90
• The Warn for Incorrect Balloon-Ids preference is enabled on page 91
• The Warn for Incomplete Ballooning preference is enabled on page 92
• The Apply Ballooning values of non-default configuration to default configuration preference is enabled

on page 92

Normal ballooning scenario
For example, consider the following

structure:

QuantityChild Configura-
tion

Child ModelParent Configura-
tion

Parent Model

1Default5004.sldasmDefault5006.sldasm

1Default5005.sldasm-do--do-

1Default5001.sldprtDefault5004.sldasm

1Default5002.sldprt-do--do-

1Default5002.sldprtDefault5005.sldasm

1Default5003.sldprt-do--do-
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1 Create a drawing, Example 5006-01.slddrw for the main assembly 5006.sldasm, as shown

below:
2 Select a view.
3 To create a BOM table, click Insert > Tables > Bill of Materials.....
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Ensure that in the BOM Type
group box, the Top level only option is selected.

4 Click OK
5 Click on a point to insert the BOM table; the BOM table is inserted as

follows:
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6 Change the column description to display the file name and configuration name, as shown below, if

required:
7 Select the view.
8 To perform auto-ballooning, click Insert > Annotations > Auto-Balloon.....
9 Click OK. The top-level components are ballooned as shown

below:
The properties are updated with the following

values:
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10 .Perform the Save to PLM operation for the drawing. The target field in PLM (of the Part List table) is
updated with the balloon value. In the current example, the target field is FIND_NO. The FIND_NO is

updated with the balloon-ids.
To update the find numbers for the child components of the sub-assemblies, namely, 5004.sldasm
and5005.sldasm, you must create drawings, repeating the above process.

When various design variants (configurations) are used
Example consider the following model files in structure:

CommentsItem-IDOriginating ItemConfigurationModel File

5020YesDefault5020.sldasm

5011YesDefault5011.sldprt

Not captured--V1-do-

5012YesDefault5012.sldprt

Not captured--V1-do-

5013.DEFYesDefault5013.sldprt

5013.V1NoV1-do-

5014YesDefault5014.sldprt

Not captured--V1-do-

The assembly has the following structure(first-level child):

CommentsBalloon-IDQuantityChild Configu-
ration

Child ModelParent Model
/ Configura-
tion

Because V1 is
not captured,
and Default is
not used as a
first-level child
within the par-
ent, so Balloon-
id of V1 will be
used.

11V1 (not cap-
tured)

5011.sldprt5020.sldasm
(Default)
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CommentsBalloon-IDQuantityChild Configu-
ration

Child ModelParent Model
/ Configura-
tion

Because the
configuration
has its own
item and is
used within the
structure as
first-level child
item, so its Bal-
loon-id will be
used.

21Default5012.sldprt-do-

Because V1 is
not captured,
and Default is
used as a first-
level child with-
in the parent,
so Balloon-id of
this will not be
considered

31V1 (not cap-
tured)

5012.sldprt-do-

Because this
configuration
has its own
item and is
used within the
structure as
first-level child
item, so its Bal-
loon-id will be
used.

41Default5013.sldprt-do-

Because this
configuration
has its own
item and is
used within the
structure as
first-level child
item, so its Bal-
loon-id will be
used.

51V15013.sldprt-do-

Balloon-Id is
missing (or bal-
loon deleted).

-1Default5014.sldprt-do-
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CommentsBalloon-IDQuantityChild Configu-
ration

Child ModelParent Model
/ Configura-
tion

Because V1 is
not captured,
and even when
Default is used.
However, the
Balloon-id of
Default is miss-
ing, so the Bal-
loon-id of V1
will be used.

71V1 (not cap-
tured)

5014.sldprt-do-

1 Create a drawing for the assembly as shown

below:
2 Perform the Save to PLM operation on this drawing. The item structure in PLM can be as

follows:

Note: 
If a configuration has its own item, and the Balloon-id for the configuration is missing, then:
• If the target field is FIND_NO, its value will be generated automatically by the integration.
• If the target field is other than FIND_NO, its value will not be modified in PLM. Its old value, if any is

retained. If this is newly getting created, then its value will be set as empty.
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If the target field is FIND_NO, then its value will be generated automatically by the integration. If the target
field is other than FIND_NO, then its value will not be modified in PLM. Its old value (if any will retain). If this
is newly getting created, then its value will be set as empty.

Same item linked to multiple documents
Example consider the following model files in structure:

BOM Defining
Comments Docu-
ment

Item IDOriginating ItemConfigurationModel File

Yes5030YesDefault5030.sldasm

Yes5021YesDefault5021-01.sldprt

No5021YesDefault5021-02.sldprt

Yes5022YesDefault5022-01.sldprt

No5022YesDefault5022-02.sldprt

The assembly has following structure (first-level child), with the ballooning done below:

CommentsBalloon IDQuantityChild Configu-
ration

Child ModelParent Model

Because this
configuration
has its own
item and is
used within the
structure as
first-level child
item, the Bal-
loon-id will be
used.

11Default5021-01.sldprt5030.sldasm
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CommentsBalloon IDQuantityChild Configu-
ration

Child ModelParent Model

Since this docu-
ment is not
BOM Defining
and the associ-
ated item is al-
so linked to an-
other docu-
ment which is
BOM defining,
the Balloon-id
of that docu-
ment will be
used.

21Default5021-02.sldprt-do-

Balloon-Id is
missing (or bal-
loon is delet-
ed).

-1Default5022-01.sldprt-do-

Since the bal-
loon-id of the
BOM Defining
document is
missing, the
Balloon-id of
this document
will be used.

41Default5022-02.sldprt-do-
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When you perform the Save to PLM operation, the item structure in PLM can be as

follows:

Multiple Views for the same [ model + configuration ] using
the same BOM table
In the following example, there are three views for the assembly. Ballooning is performed for the views using
the same BOM table, as shown

below:
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Multiple BOM tables for the same [model + configuration]
In the following example, there are four views and two BOM tables. The two views on left refer to the BOM
table on the left-bottom, and the two views on the right refer to the BOM table on the

right-bottom.

When you perform Save to PLM, views that are linked to first BOM table are checked first. if a view linked to
the first BOM table exist, the ballooning information from all the views linked to the BOM table is passed to
the integration. The views that are linked to the second BOM table are not checked. The results are as

below:
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If the ballooning is not performed for any of the views using the first BOM table, the information form the
views linked to second BOM table is retrieved. In the following screen, the balloons of the first view is

deleted:

The result after Save to PLM can be as

follows:

The Warn for Duplicate Balloon-Ids preference is enabled
In the following example, the same balloon-id is specified for two component files and both the component
files are linked to the same

item.
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If the Warn for duplicate balloon-ids preference is enabled, the following dialog box is

displayed:

This dialog box is displayed only once for a particular parent item (of a model file). It is not repeated, even if
the multiple child items have this problem. This information is used for updating the Part List table field (in
PLM). if the target field is FIND_NO, ballooning information of the child item of this parentis not updated.
Effectively, BOM is updated but not the FIND_NO field.

The Warn for Incorrect Balloon-Ids preference is enabled
In the following example, two different balloon-ids are specified for the same child

component.

The following dialog box is

displayed:

Note: The process is not stopped, even though a warning message is displayed.
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The Warn for Incomplete Ballooning preference is enabled
In the following example, the ballooning information does not exist for the second child

model.

If the Warn for Incomplete Ballooning preference is enabled, the following error message is

displayed:

This message is indicative, the ballooning information is updated in the PLM. However, the information is
incomplete.

The Apply Ballooning values of non-default configuration
to default configuration preference is enabled
Consider a scenario wherein all the following conditions are met:

• The Apply Ballooning values of non-default configuration to default configuration preference is enabled.
• The assembly contains the multiple configurations.
• Only one configuration(default) contains the item.
• The ballooning information doesn't exist for the default configuration.

In the above scenario, the ballooning information of the other configuration(s) is applied to the default
configuration. When the Apply Ballooning values of non-default configuration to default configuration
preference is disabled, the default value is Yes.

For this example, consider the following file details:

• 7010.slddrw (contains view of the V1 configuration of the 7010.sldasm assembly)
• 7010.sldasm (Configurations: Default, V1)
• 7001.sldprt (Configuration: Default)
• 7002.sldprt (Configuration: Default)
• The 7010.slddrw drawing contains view of the V1 configuration of the 7010.sldasm assembly.
• The 7010.sldasm assembly contains only one item (for the default configuration, Default) and the

configuration V1 is not captured.
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There exists no view that contains the ballooning information of the configuration, Default. Therefore, the
ballooning information of other configurations of this file are considered. Since there is ballooning information
for configuration V1 of this file, so system will pick the Ballooning information of V1 and will use/apply the
same for the Default

configuration.

After the Save to PLM operation is performed, the BOM information in PLM is displayed

as:
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Chapter 27: Renaming of SolidWorks Files

Renaming option enables you to rename the SolidWorks files via PLM integration menu in SolidWorks
application.

To access the rename option you must connect to PLM from SolidWorks. Select PLM in SolidWorks menu and
click Rename. Following are the two options to rename files:

• Rename - Active file
• Rename - Active file structure

Following figure displays rename menu:

Following figure shows Rename option in the

toolbar:

The renaming options performs following operations:

• Renames the files in local folder.
• Renames the files in PLM server.
• Corrects the referenced file names under parent/referenced files and uploading of files into PLM server.

Rename - Active File
If you click Rename > Active File, integration checks whether the active file exists in PLM or not. If the active
file exists in PLM, then following steps are performed:

1 Click Rename > Active File. The Save As dialog box in SolidWorks opens. Specify the new filename in the
Save As dialog box and click OK. SolidWorks renames the file locally and replaces the references of this
file under any file that is loaded in application session.

2 Integration corrects the references for those files (under the structure of currently open files) that are
not loaded in session but has direct reference to the currently renamed file.

3 Active file is renamed in PLM. Integration sets the data set field Orig. file name (FILE.ORIG_FILE_NAME)
with the value of its original filename.

4 The file name of the Neutral files (if any) for this renamed file is also corrected according tonew names.
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5 Since the active file has been modified via application, it is uploaded in PLM.
6 The parent files (whose references were corrected or got corrected above and which exist in PLM) are

uploaded in PLM.
7 Results of renaming active file is displayed.

Rename - Active File Structure
If you click Rename > Active File Strcuture, the following steps are performed:

1 Click Rename > Active File Structure. The Rename Files dialog box opens. This contains list of all files
(under the structure of currently active file which are allowed for renaming) wherein you can specify the
new filename for one or more files.

2 Click OK. Integration prepares a list of all files under the structure of currently open files which have
direct reference to the files that are getting renamed.

3 Integration closes the files that are open.
4 Files that are marked for renaming are first renamed locally (at O/S level) to their new filenames.
5 Referenced file names is corrected on the files that have direct reference to these renamed files.
6 Files names are updated in PLM with the new filenames. Integration also sets the data set field Orig. file

name (FILE.ORIG_FILE_NAME) with the value of its original filename of these files.
7 All the files whose references have been modified (and which exist in PLM) are uploaded into PLM.
8 File name of the Neutral files (if any) for these renamed files is also corrected according to new names.
9 File that was originally active is re-opened
10 Results of renaming is displayed.

Corrections of file references during Edit file:
There can be certain files in PLM whose referenced files were renamed, but their referenced paths were
not corrected. This is handled when you Edit/View file operation. During Edit file, it checks if any of the
files references were renamed. If it is renamed it corrects the referenced filenames for those files and
uploads these files into PLM.

Rename Files - Preference
Renaming of active file in PLM using SolidWorks menu File > Save As:

If the integration preference Rename file in PLM on File > Save As operation is set to True, and when you
perform File > Save As operation on active file, integration will perform the same set of operations as Rename
> Active file.

Note: 

• Before running these operations, you must set the following SolidWorks option to True.
• Only those files which exist in PLM are considered for renaming and/or uploading into PLM.
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• If the preference Allow operations on previous revisions is set to true; then during these menu operations,
integration allows you to rename and/or correct the file references of previous revision of files also. By
default, integration allows to perform rename and upload of latest revisions of files. Note that during
Edit/View file in Integration, integration corrects the references and upload the file even if the file is of
previous revision irrespective of this preference value.

• During these operations, integration renames only the current version of the file which exists locally.
Other versions of the files are not renamed, they retain their original names.

• After renaming the files, ensure that the referenced file names are corrected in all the files that have
references to this file. Do not rename a file multiple times unless and until the referenced filenames are
corrected in all the files that have references to this file.
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Chapter 28: Integration Preferences

The PLM integration preferences control the way the PLM integration for SolidWorks works.

Users locally manage integration properties for which they have been authorized by the administrator. The
local integration properties are specific to each user. Your settings do not affect the properties of other users.

Users manage their local integration properties in the PLM Preferences pane. To access the Web PLM
Preferences pane:

1 In SolidWorks, select the PLM menu.
2 From the PLM menu, select Preferences or in the toolbar, click Preferences. The PLM Preferences screen

is displayed.

The PLM Preferences screen is displayed.

The PLM Preferences screen includes these tabs:

• SolidWorks
• Toolkit
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Chapter 29: SolidWorks Tab

The SolidWorks tab includes properties that control the behavior of the PLM integration for SolidWorks. This
tab includes the following options:

• Locations on page 98
• Initial Save Option on page 99
• General Option on page 102
• Save Neutral Files Option on page 67
• Post Save Process on page 107
• After Check In Option on page 110
• Attach to Workflow on page 108
• Troubleshooting Option on page 110
• Integration Preferences for Balloon Mapping on page 77
• Integration Preferences for Thumbnails on page 72
• Integration Preferences to Save Changes to PLM on page 55
• Set Item-ID during Initial Save on page 110
• Renaming of SolidWorks Files on page 94

Locations
To carry out various commands, such as View File in Integration or Edit File in Integration from the Results
panel of the integration query, PLM must locally download the files that you want to view or edit in SolidWorks.
In the Locations section you can specify the folders in which PLM must locally download the files that you
want to view or edit in SolidWorks. If required, you can specify the same folder for both viewing and editing,
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but if you do this, the Disable Actions on view files property will not

work.

Initial Save Option
The properties comprising the Initial Save Option determine how files behave when saved to PLM for the
first time. The following properties are

available:
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Concatenate Item/ File ID
If this check box is selected, SolidWorks files are renamed during the first save to PLM. Drawing files are
renamed by adding the related PLM file ID as a prefix to the name of the file being saved. For all other files,
the related PLM Item ID is used. This means that users do not have to worry about using duplicate file names,
because this feature ensures that the name of SolidWorks files saved to PLM are always unique.

Note: To use the Concatenate Item/File-ID option, in the System Options - External References dialog box in
SolidWorks, the Update component names when documents are replaced check box must be selected, as
shown in the following picture.

In SolidWorks, to access this dialog box, select Tools > Options > External references.

If the Concatenate Item/File-ID to all files on first save to PLM check box is selected, but the SolidWorks Update
component names when documents are replaced check box is not selected, the PLM integration will
automatically select this check box. If this check box has been selected by thePLM integration, it will be cleared
when the user logs out from PLM

In addition, to open renamed files from PLM, make sure that the relative search path for file locations is set
correctly in SolidWorks. For further information, see Concatenate Item/File-ID.

Create documents only
If this check box is selected, when you save a file to PLM, a document is created in PLM, but no items are
created. For further information, see Saving to PLM.

Infor PLM for Discrete SolidWorks User Guide | 100

 

SolidWorks Tab



Must assign an item
If this check box is selected, when you save a file to PLM, you must assign an item to the objects. PLM does
not allow you to proceed without assigning an item.

Set Object Attributes During Save
If this check box is selected, you can define attributes for the files, documents and items that are being saved
to PLM. For further information, see Saving to PLM.

Manual ID entry for documents and/or items
When Manual ID check box is selected in the preferences, you can specify IDs for the Item and

Documents.

Set object to match file name
If this check box is selected, the integration creates the Item ID, Document ID, Filename, and File ID based on
the same identifier. When user saves a file with a specific name, it is assumed that this filename (without the
extension) is the base identifier. When the file is saved to PLM, the integrations sets the IDs for all components
based on that filename.

Set Object to Match Filename preference preference is set

Set Attributes Dialog During Save preference is not set

Limitations
Following is the known limitation when you set objects to match file name:

• If you modify the Item-Id, specified in the Set Attributes dialog for multiple times, the count in the item
revisions increases. It is recommended to specify the Item-ID only once in the dialog.

Note: It is recommended not to specify the same Item-Id for two files in the Set Attributes dialog box.
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General Option
The General Option includes the following properties:

• Allow Link to Released Item on page 102
• File Name Uniqueness on page 102
• Disable Actions on View File on page 103
• Query Search Default on page 103
• Save Additional Drawings on page 103
• Download Additional Drawings on page 103
• Allow reload of already opened files on page 103
• Show Message on Successful Open on page 104
• Warn User when the same item is linked to parent and child components on page 104
• Take Ownership During Edit File on page 104
• Skip Mapping for Released Files during Download on page 104
• Skip Meta Data Comparison During Download on page 105
• Warn for Missing CheckIn Specific Modified Mapping XML File on page 105
• Set CAD Instance Name as Item-ID on page 105
• Generate Items for all Configurations on page 105
• Save External References on page 105
• Resolve light-weight components during Save to PLM on page 106
• Create Separate BOM lines for component files linked to Same item on page 106
• Update items with ERP Item Default Data automatically on page 106
• Link Drawing to all Items of Child Model on page 106
• Process Impacted Documents during download on page 107
• Indicator for Locally Changed Files in Download Manager dialog on page 107

Allow Link to Released Item
Your Concept

File Name Uniqueness
If this check box is selected, the names of the files stored in PLM are unique.

If this check box is cleared, you can store multiple files with identical file names in PLM but in different projects.
It is not recommended to clear this check box, since it might cause problems if you want to

download a file while a file with an identical name already exists locally. For example, you cannot use multiple
files which have identical file names ; from different folders ; in one assembly.
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Disable Actions on View File
This option is used to prevent the user from modifying files that he opened from the integration query results
using the View File in Integration option. If this check box is selected and the user clicks a PLM menu option,
for example, Save to PLM, a message appears informing him that the file is read-only.

Note that for the Disable Actions on View File option to work, the view and edit locations specified in the
Locations option must be different. For further information, see Locations on page 98.

Query Search Default
This option defines how the integration query tool is opened from the PLM menu in SolidWorks and determines
the query objects. The following options are available:

• ITEM
• DOCUMENT
• FILE

Save Additional Drawings
If this check box is selected, the following operations save the local editable drawing files of all the editable
and/or non- editable models of the current CAD structure to PLM:

• Save to PLM
• Save and Unlock
• Check-In

Download Additional Drawings
If this check box is selected, the Edit/View file in Integration option enables the user to download the related
drawings of all the models in the current Document structure.

Allow reload of already opened files
If this check box is selected, you can replace and reload open files. In the Download Files dialog box, Reload
Already Open Files check box is included.

To replaces the local file with the files in the PLM, click OK. The replaced are automatically opened.

By default, the Reload Already Open Files check box is selected, based on the setting of the Allow reload
of already opened files field in the Integration Properties for Integration dialog box.
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When you perform reload operation on drawing files, the drawing files are closed, re-placed, and re-opened,
as a result of a SolidWorks limitation.

It is recommended that user save the open documents locally before executing the Edit/View File in Integration
process.

Download Files - Commands:

Progress Bar
The progress bar indicates the status of downloading of the files from the PLM to the local system.

Select the Skip Mapping for Released Files check box to skip the To-CAD mapping for the files that are in
Released status in PLM. The default value for this check box is defaulted based on the integration preference
Skip Mapping for RELEASED files during Download. You can select the check box to download large assemblies
in order to improve the performance of the download operation.

Refresh Already Open Files
Synchronizes the currently open file with the latest file in PLM.

Restore Archived Files
Retrieves the file from the archive area.

Show Message on Successful Open
If this check box is selected, a message is displayed after downloading ( Edit/View file ) files from PLM.

Warn User when the same item is linked to parent and child
components
If you select the Warn User when the same item is linked to parent and child components checkbox, PLM
warns the user that the same item is linked to parent and child components.

Take Ownership During Edit File
When Take Ownership during Edit File preference check box is not selected, the users do not take the
ownership of the files even when they execute Edit File command.

Skip Mapping for Released Files during Download
When you select the preference Skip Mapping for Released Files during Download, the integration does
not perform the mapping for the files which are in Released status in the PLM during the download process.
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It is recommended to select the check box to improve the download performance of large assemblies in the
View/Edit File operation. However, you should be aware that some file preferences may not be up to date
with PLM.

Additionally, it is also possible to select the Skip Mapping for Released Files.

The default value for this check box is defaulted based on the integration preference Skip Mapping for
Released Files during the download.

Skip Meta Data Comparison During Download
When Skip Meta Data Comparison During Download check box is not selected in the preferences. The
Download Manager indicates if there is any change in the PLM data of Document/ Item/File.

If the Download Manager indicates the data change, it is recommended to download the indicated files. Hence
the Download option for the specific changed file is set to true by default.

Warn for Missing CheckIn Specific Modified Mapping XML File
If this check box is selected, and if the ModifiedMappingRulesForCheckIn.xml is not available in the %CFE_CLIENT_
HOME% Toolkit directory , the PLM warns the user that the file is missing.

Set CAD Instance Name as Item-ID
If you select the Set CAD Instance Name as Item-ID check box, PLM sets the name of the CAD instance as
the item ID. For more information, see Set CAD Instance Name as Item-ID on page 111.

Generate Items for all Configurations
If this check box is selected, items for all the configurations are generated and linked to document in PLM
when you perform the Save to PLM operation, regardless whether Capture Design Variants steps are performed
or not.

Save External References
If this check box is selected, during the Save To PLM operation, the relations between the files SW files are
stored in PLM. For more information, refer to Associative Links on page 47.
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Resolve light-weight components during Save to PLM
SolidWorks supports a mode for assembly components called lightweight. A lightweight component contains
only a small subset of its data for display purposes, which increases system performance when loading
assemblies. The extra data is not loaded until it is required.

If this check box is selected, while reading BOM of individual configurations, PLM integration activates the
desired configuration and initiates this API to resolve all lightweight components during save to PLM.

Note: In case of large assemblies, this API can take a lot of time and also the memory limit of Process can
exceed (specific to O/S) and result in exception/ application crash. In such case you can clear this checkbox.

Create Separate BOM lines for component files linked to Same
item
If this check box is selected, when the two different components in an assembly are linked to the same item,
then Save To PLM operation will create two different BOM lines in the PLM.

Update items with ERP Item Default Data automatically
If this check box is selected, and Create Documents Only check box is not selected integration sets the values
of certain attributes based on ERP default’s data (for the combination of ITEM_TYPE & ITEM_GROUP). This
preference is applicable for the items that are created for the file during Save to PLM.

For example, Select the Update items with ERP Item Default Data automatically checkbox and do not
select the Create Documents Only checkbox in the SOLIDWORKS Preferences > General.

Create new part and perform Save to PLM.

Before the Set Object Attributes dialog is displayed, the integration sets the attributes of Items based on Item
default data as defined in PLM.

Link Drawing to all Items of Child Model
If this check box is selected, the integration links (as Related Models) all the Items representing different
configurations of the model to the Document of the drawing.

If this preference is not selected, only those items for which drawing view is created will be linked to the
document of the drawing as Related Models.
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Process Impacted Documents during download
If this check box is selected, then when a file is downloaded, all of its impacted documents (for which the file
is a driver document) will also be downloaded. This preference is applicable for documents that are linked
with each other as Driver Document/ Impacted Document.

For example, create a part file (P1.sldprt) and a mirror part (MP.sldprt). Select the preference Save External
References and Process Impacted Documents during download. Perform Save to PLM.

The document of P1.sldprt is linked with the document of MP.sldprt as Driver Document and the document
of MP.sldprt is linked with the document of P1.sldprt as impacted document

Select the document of P1.sldprt and perform Edit file, the file MP.sldprt will also be considered for
downloading.

Indicator for Locally Changed Files in Download Manager dialog
The value Y for the Identical field of the PLM - Download Files dialog box distinguishes between the files that
are changed in PLM and locally by the user.

Following are the possible values for the Identical field:

• Y: Local file is identical to the file in PLM.
• N: The file in PLM is different from the file on the local system.
• Y – Locally Changed: Indicates the file in PLM is not changed, but there are some changes made to the

file on the local system.

Post Save Process

CheckIn Cleanup
The available options are:

Delete File
After check-in, ONLY the root file will be deleted from local system. All other files(within the structure) will
be read-only.

Make files read-only
After check-in, all the files (within the structure, including the root file)will be made read-only in the local
system.
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Save and Unlock Cleanup
The available options are:

Delete File
After save and unlock, ONLY the root file will be deleted from local system. All other files (within the structure)
will be read-only.

Make files read-only
After save and unlock, all the files (within the structure, including the root file) will be made read-only in the
local system.

Show message on successful save
If this preference is selected, after Save to PLM/Save and Unlock/Check-In actions are successful, a dialog is
displayed to indicate that the process is successful.

Attach to Workflow
Use the Attached to Workflow property to control the Dispatch to Business Process functionality. The Attached
to Workflow property comprises of the following options:

• Attached to Business Process on page 108
• Attached related Models\Drawings on page 109
• Attach all related objects on page 109
• Action for objects locked by Business Process on page 109
• Attach Draft Objects Only on page 109
• Attach All Items on page 109

Attached to Business Process
This option controls the PLM objects of a SolidWorks file that can be attached to the business process. Allowed
values:

Documents Only
Only the documents associated with the SolidWorks file are attached to the business process.

Items Only
Only the items associated with the SolidWorks file are attached to the business process.

Both
Both the documents and the items associated with the SolidWorks file are attached to the business process.
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Attached related Models\Drawings
If this check box is selected, the PLM objects(items, documents) of the models or drawings associated with
the SolidWorks file are attached to the business process. The PLM objects attached to the business process
are based on the values selected for the Attached to Business Process preference.

Attach all related objects
If this check box is selected, the PLM objects (items, documents) of all the components in CAD structure of a
Solidworks file are attached to the business process. The PLM objects attached to the business process are
based on the values selected for the Attached to Business Process Preference.

Action for objects locked by Business Process
This preference indicates what action must be taken if one or more objects are already locked by another
business process. The available options are:

Attached as unlocked
The object will be attached to Business process and unlocked.

Do not attach
The objects that are locked will not be considered for dispatch.

Cancel action
The dispatch operation will be cancelled.

Attach Draft Objects Only
This preference is applicable for both Documents and Item objects. If this preference is selected, only Draft
objects (ITEMS/ DOCUMENTS) can be attached. If this checkbox is not selected, no check is made with respect
to object status.

Attach All Items
If this preference is selected all the Items linked to the document are considered during dispatch. If this
preference is not selected, then only default item is considered for dispatch.
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Troubleshooting Option
Use this option to specify whether log files must be created for various processes of the PLM integration for
SolidWorks. You are recommended to create these log files if you are experiencing problems with the
integration, and, if required, to send the log files to the PLM support group.

Set Item-ID during Initial Save
Set Item-ID based on
The available options are:
• None
• File Name
• Part Number
• Custom Property [Document Level]
If the Set Item-ID based on is set to File Name and Create Documents Only preference is not selected,
during save to PLM, integration sets the Item-ID matching to File Name.
If the Set Item-ID based on is set to Custom Property [Document Level], you must the set the following
preferences:
• Specify the Custom property to use as Item-ID. For example, specify CAD Item Number. This can be

the name of any custom property that is defined in the CAD file.
• The Create Documents Only preference must not be selected.
Create a part file. Create a custom property and specify the name as defined in Custom property to use as
Item-ID preference. For example, CAD Item Number. Specify a value for the property. For example, specify

1700.11.
Save the file to PLM. For the new item that is getting created, integration sets the Item-ID in the Set Object
Attributes window as the value specified in custom property.

After Check In Option
Use the properties of the After Check In Option to define what happens to a local SolidWorks file after it has
been copied to the PLM vault during the check-in procedure.

The available properties are:
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Make Files Read-Only
The files are left in the SolidWorks directory, but cannot be updated.

Delete File
The files only exist in the PLM vault. To work on them in SolidWorks, you must you must retrieve them from
PLM using the Edit File or View File commands and check out the file either before or after the retrieval. For
further information, see Checking out a file.
Note that if the Deleted option is selected and the local file that is deleted belongs to an assembly, the
following applies:
• If the file that is checked in is the root of an assembly, the integration only deletes the local copy of the

root object that is checked in. The integration deletes the root object without checking whether the root
object is used in another assembly.

• No local versions of the sub-assemblies or components of the checked in root object are deleted, because
the user may be working with other assemblies that use the same components, which therefore must
remain on the local machine.

To define the action to be performed on the local SolidWorks files, select the required radio button and click
OK.

Set CAD Instance Name as Item-ID
If this check box is selected, the integration uses the following naming conventions in creating the new Item-Ids
for the configurations of the CAD file.

• If there is a User-specified name for that Configuration in the CAD file, then the User-specified name is
taken as the basis of Item-ID (for creating the Item).

• If there is no User-specified name for the Configuration, then the integration uses the configuration name
as the basis of Item-ID (for creating the Item).

The Item-ID is automatically selected when the following PLM 8 menu actions are performed:

• Saving Files to PLM on page 18
• Design Variants on page 44
• Link to Item on page 24

Toolkit Tab - Introduction
The Toolkit tab includes properties and definitions that can be shared with other integrations for PLM. This
tab includes the following options:

• General Option
• Toolkit Extensions to Original Application
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Synchronize All Files During Save
If this check box is selected, PLM checks whether the file header is consistent with the data in stored in PLM.
Clearing this check box can save time during the save process.

Ignore Items
If this check box is selected, there will be no actions related to items from the integration.

Disable BOM Creation/ Modification during Save
If this check box is selected, there will be no actions related to BOMs (bills of material) from the integration.

Show Synchronize message during Save
If this check box is selected, the PLM integration for SolidWorks will display the synchronization dialogbox
during save operations.

Enable Selective Checkout
Use this property to enable or disable the option to operate selective check-out from the PLM integration for
SolidWorks integration.

Automatically set resolve filename to New
When you save a new file to PLM and the integration identifies that a file with the same name already exists,
the Resolve Filename dialog box is displayed.

This functionality allows the users to save the file with the same names to different projects without responding
to the Resolve Filename option.

When you set this new preference with the combination of preference File Name Uniqueness = false, the
integration process checks that a file with this name doesn’t exist in the current project, and assumes that
the file saved to PLM is the new one. In this case the integration creates a new PLM document without displaying
the Resolve Filename dialog.
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Toolkit Extensions to Original Application
This option lists the extensions that the integration uses to interact with other CAD applications.

The file extensions are linked to the integrations that will be used to open the file. For example, files with
extensions SLDPRT, SLDASM, SLDDRW should be linked to the ORIGINATING_APP value SolidWorks. This link
enables PLM to determine how to open the file.
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Chapter 30: Troubleshooting

Please note the following, before you install the SolidWorks Integration:

Toolkit and Logwininet log files
The PLM support group may ask you to provide them with additional information about problems you may
be experiencing with one of the PLM integrations.

To provide the support group with this additional information, the following log files can be created:

• Toolkit81Log
• Toolkit81_OpenLog
• Logwininet Log

To create these log files, proceed as described below. If you require further assistance creating these log files,
please contact the PLM Support group or your local technical support department.

Note: In case you encounter any issues during the PLM operations from integration, do the below steps:

• Create the folders %tmp%\logwininet and %tmp%\toolkit. If these folders are existing, then delete the
files in these folders.

• Reproduce the error
• Provide the following files along with the screen dumps of the error messages and the steps to reproduce

the error.
• Files created in the folders %tmp%\logwininet and %tmp%\toolkit.

In certain cases, it is possible that the support team might require the CAD files also.

Toolkit log
To create toolkit logs, you must create a folder as "Toolkit" under %TMP%.

The names of the resulting log files are:

• Toolkit81Log_<process id>_<thread id>_[<number>].txt
• Toolkit81_OpenLog_<process id>_<thread id>.txt
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Logwininet log file
To create the logwininet log file, create a directory titled Logwininet under the directory specified by your
%TMP% environment variable.

The names of the resulting log files are:

• LogTrace_<thread id>.log
• LogTrace_<thread id>.err

Note: Only configure your system to create these logs when requested to by the PLM Support group. After
the required logs have been created, logging must be turned off. Failure to turn off the logging will result in
a severe reduction of the performance of your system and lead to a considerable use of your disk space.

CAD application not available in Application list of
Mapping Tool dialog box
To define mapping rules for a particular SolidWorks template, in the PLM Mapping Tool dialog box, you must
first select SolidWorks in the Application list and then select the template for which you want to define the
mapping rules. However, sometimes SolidWorks is not available in the Application list.

Recommendation
In file C:\ProgramFiles\PLM Client\config\settings\cfeMappingTool.xml, add the following line to the
<APPLICATIONS> list:

<APPLICATION ID="SOLIDWORKS" LABEL="SolidWorks"

TEMPLATE_CONVERT_APP="SolidWorks/SW_ITC.exe" />

The IN_ITC.exe convector is the utility used by the CAD applications for converting mapping

templateinformation to xml.

In addition, make sure that the directory and executable  SolidWorks/SW_ITC.exe indicated in the applicable
TEMPLATE_CONVERT_APP line is located in the PLM installation directory.

The entries in the cfeMappingTool.xml file use forward slashes (/) even though the windows standard is to use
backward slashes (\) as a path separator.
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Setting the Path for the Edit/ View in Integration
To ensure that the Edit/View in Integration from PLM operates correctly, the path of the related CAD application
executable or batch file must be defined in the RunCad81.properties file. This file is located in the folder %
CFE_CLIENT_HOME%ToolKit.

The following default entries exist in this file and should be adjusted to match your installation:

Note: 
SolidWorks= C:\Program Files\PLM_Client\SolidWorks\ConnectToSW.exe
If a path contains a space (such as in Program Files), the path must be put between quotes.
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Chapter 31: Recommendations and FAQs

The best practices with regard to the use of the PLM integration for SolidWorks are addressed in the form of
a Frequently Asked Questions (FAQ) sheet.

The FAQ includes the following:

• How to Improve Performance on page 117
• Saving files to PLM - best practices on page 118
• How do I introduce a new product to PLM? on page 118
• Can other people in my group perform changes to the same assembly I work with? on page 119
• When I work with large assemblies and save them to PLM it takes a long time to complete the operation.

on page 119
• What happens if I have unlocked a component and then realize I must change it? on page 119
• After saving to PLM, how can I verify the results in PLM? on page 119
• Can I perform PLM operations on the components of my assembly or only on the root? on page 120
• Which procedures do you recommend for concurrent engineering? on page 120
• When I work in a concurrent engineering environment, how can I get the components that other users

have changed and that are used in my assembly without closing any files? on page 120
• How can I operate the download manager without opening the files in SolidWorks? on page 121
• Why does the Resolve File Identity dialog box appear when I save a file to PLM? on page 121
• How can I find PLM information for files that exist locally on my computer? on page 121
• When I modify a complex assembly, which components must be checked out? on page 122
• How does the integration manage the link between drawings and items? on page 122

How to Improve Performance
The following are the best practices in PLM:

• It is recommended to use the same folder for both EDIT and VIEW operations; for all users. Same EDIT
and VIEW folders allow PLM to improve the download performance.

• It is recommended to frequently perform the Synchronization operation when you work with large
assemblies. Synchronization operation allows you to identify the files modified in PLM.You can use the
command Refresh Files from PLM to download the modified files. See Refresh Files from PLM on page
43
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Saving files to PLM - best practices
Saving to PLM draws heavily on your configuration’s resources. To save system performance, you are
recommended only to save to PLM when updating the associated PLM documents, items, and files is actually
required. For routine saves, use local save options.

In addition, the PLM Check in and Save and Unlock commands also save your data to PLM. Therefore, if the
goal of your current session is to check in or save and unlock your part file, you can save your file locally from
time to time and complete working on your file by checking in or using Save and Unlock.

• It is recommended to use the same folder for both EDIT and VIEW operations; for all users. Same EDIT
and VIEW folders allow PLM to improve the download performance.

• It is recommended to frequently perform the Synchronization operation when you work with large
assemblies. Synchronization operation allows you to identify the files modified in PLM. You can use the
command Refresh Files from PLM to download the modified files.

Open referenced documents with read-only access
To work correctly with the PLM integration for SolidWorks, in the System Options - External References dialog
box in SolidWorks, the Open referenced documents with read-only access check box must not be selected,
as shown in the following picture.

If you select this check box, files opened from PLM for editing purposes may have read-only instead of
read-write access.

In SolidWorks, to access this dialog box, select Tools > Options > External Preferences.

How do I introduce a new product to PLM?
If you work on a new large assembly not yet saved to PLM, you can highlight the top model of this assembly
in the SolidWorks Feature Manager, and then save the entire structure to PLM. If you complete a component
in a large assembly, select this component in the SolidWorks Feature Manager, and perform Save and Unlock.

For further information, see:

• Saving and Unlocking Files on page 27
• Saving Files to PLM on page 18
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Can other people in my group perform changes to the
same assembly I work with?
If you save an assembly to PLM, you own all of its components. Therefore, they are locked from use by other
users. To allow other users to work on a subset of the same assembly, perform Unlock for the required
components or perform Change Ownership.

For further information, see:

• Saving and Unlocking Files on page 27
• Changing the ownership of a file on page 32

When I work with large assemblies and save them to PLM
it takes a long time to complete the operation.
After the initial save, perform Unlock on all components you must not change. During the save operation, the
Take Ownership List dialog box displays a list of all unlocked writable files. Ensure you only select the files
that you changed.

For further information, see:

• Saving and Unlocking Files on page 27
• Saving Files to PLM on page 18

What happens if I have unlocked a component and then
realize I must change it?
You can perform the Take Ownership operation to ensure you own the component. For further information,
see:

• Saving and Unlocking Files on page 27
• Taking Ownership on page 32

After saving to PLM, how can I verify the results in PLM?
The Show Meta Data operation displays a dialog box with all the PLM file, document, and item data as it was
saved to PLM. You can also use the Open in Document Workspace, or Open in Item Workspace options to
see the data in a Show Meta Data structure workspace.
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For further information, see:

• Viewing PLM Data on page 34
• Opening a file in PLM on page 36

Can I perform PLM operations on the components of my
assembly or only on the root?
You can perform any PLM operation on any component you select in the SolidWorks Feature Manager.

When I work in a concurrent engineering environment,
how can I get the components that other users have
changed and that are used in my assembly without closing
any files?
You can click Refresh files from PLM to update the currently open files from Infor PLM. For more information,
refer to Refresh Files from PLM on page 43.

Which procedures do you recommend for concurrent
engineering?
There are two approaches to manage file changes for teams working on assemblies. After users have completed
their work on a specific subset of an assembly, they can do one of the following:

Perform Save and Unlock
When the entire assembly is saved to PLM, the integration displays the Take Ownership List dialog box. This
dialog box shows the writable files, so the user can select those files that must be saved to PLM. The user
should avoid selecting files that were not changed.

Perform Check In
After a file is checked in, you cannot change it until it is checked out (minor check-out in this case). Therefore,
each time you check in a file, it is saved to PLM, and later changes are saved in a new version of the file.

For further information, see:

• Saving and Unlocking Files on page 27
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• Taking Ownership on page 32
• Checking in a File on page 28

How can I operate the download manager without
opening the files in SolidWorks?
Ensure SolidWorks is closed and then perform Edit File in Integration, or View File in Integration from PLM.
For further information, see Working with the Results Panel.

Why does the Resolve File Identity dialog box appear when
I save a file to PLM?
The integration stores data in a specific location on your computer. This data allows the integration to establish
a link between the files stored locally on your machine and the PLM data.

If this information is not available for the integration, and you try to save a file that already exists in PLM, the
Resolve File Identity dialog box appears. For example, this dialog box appears if you copy the SolidWorks file
to a different directory and then save it to PLM. For further information, see Saving Files to PLM on page 18.

How can I find PLM information for files that exist locally
on my computer?
To find PLM information:

1 Open SolidWorks without any file.
2 On the PLM menu, click Show Meta Data.

The PLM details are displayed in a dialog box for all the files present in the integration locations on your
computer. This dialog box displays only the data saved locally. If data has been changed in PLM, you
must perform Synchronize Header.
For further information, see:
• Viewing PLM Data on page 34
• Synchronize Headers on page 39
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When I modify a complex assembly, which components
must be checked out?
Only check out the components you must change. Note that if you check out a component without checking
out the assembly in which the component is used, you must save this component separately. If a subassembly
is RELEASED, the integration does not check the subcomponents of this assembly, which enhances the
performance of the save operation. For further information, see Checking out a File on page 30.

How does the integration manage the link between
drawings and items?
There are two types of links between SolidWorks documents and items. The simple Related Document link
only contains the link between an item and its model document. The Related Drawing link only contains the
drawings created in the PLM integration for SolidWorks. The item workspaces in the PLM client utility allow
users to view this information and make changes to the links, if required.

For further information, see Saving Files to PLM on page 18.
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